
1/75 7010081003 C

CASE Sensors

SAUTER CASE Sensors
Version 2.2

Parameterising sensors
Manual
7010081003 C



2/75 7010081003 C

CASE Sensors



3/757010081003 C

CASE Sensors

Content

Content

1	 Preface	 5
1.1	 Most important features	 5

2	 Introduction	 7
2.1	 Information on use	 7

3	 Overview	 9
3.1	 General configuration process	 9
3.2	 Program structure	 11

4	 Safety warnings	 13

5	 Installation	 15
5.1	 System requirements	 15
5.2	 Scope of delivery	 15
5.3	 Software installation	 15
5.3.1	 Installation of SAUTER CASE Sensors	 16
5.3.2	 Installation of driver for interface converter	 18
5.3.3	 Check installation	 19
5.3.4	 Uninstalling the software	 20

6	 Connection and configuration	 21
6.1	 Connect the interface converter	 21
6.1.1	 Connection with an EGP100	 22
6.1.2	 Connection to an SGU100	 22
6.1.3	 Connection to the EGQ181 and EGH681	 23
6.1.4	 Setting the COM port	 24
6.2	 Ending the configuration	 28
6.3	 Extras	 30
6.3.1	 Select communication address	 30
6.3.2	 Options	 31
6.3.2.1	 Units	 31
6.3.2.2	 Language 	 32
6.3.2.3	 Communication 	 32

7	 User interface	 33
7.1	 General structure of the user interface (example: SGU100)	 34

8	 Parameterisation	 37
8.1	 Starting the program	 37
8.2	 Start page	 37
8.3	 Export configuration	 38
8.4	 Import configuration	 38
8.5	 Print configuration	 39
8.6	 Network settings	 40
8.7	 Configure device 	 42
8.8	 Parameter settings	 43



4/75 7010081003 C

CASE Sensors

Content

8.8.1	 Overview	 43
8.8.2	 Project data	 43
8.8.3	 Parameters	 44
8.8.4	 Device data	 44
8.8.5	 Monitoring	 44
8.9	 Diagrams	 46

9	 Device-specific parameterisation	 47
9.1	 Differential pressure transducer EGP100	 47
9.1.1	 Adjustable device parameters 	 47
9.1.2	 Application examples	 50
9.1.3	 Service functions	 51
9.2	 Sash sensor SGU100	 52
9.2.1	 Adjustable device parameters	 52
9.2.2	 Application examples	 54
9.2.3	 Service functions	 54
9.2.4	 Status display	 57
9.3	 Room humidity and temperature sensor EGH681	 58
9.3.1	 Adjustable device parameters	 58
9.3.2	 Service functions	 60
9.4	 Air quality sensor (VOC) EGQ181	 61
9.4.1	 Adjustable device parameters	 61
9.4.2	 Service functions	 62

10	Customer service	 63

11	Rectifying problems	 65

List of abbreviations	 67

Index	 73



5/757010081003 C

CASE Sensors

Preface

1	 Preface

Congratulations on choosing Sauter software. SAUTER CASE Sensors Software 
Version 2.2 is intended for use with the following SAUTER sensors/transducers:

•	 EGP100 differential pressure transducer 
•	 SGU100 sash sensor
•	 EGQ181SF203 air quality sensor (VOC)
•	 EGH681SF233 humidity and temperature transducer

These items are quality products from a leading manufacturer of technical control 
equipment for heating, ventilation and air conditioning.

This manual describes the SAUTER CASE Sensors configuration software, which 
was specifically developed for simple and cost-optimised parameterisation of the 
sensors mentioned above. The SAUTER CASE Sensors software tool offers menu 
guidance so that you can make all the settings required for this sensors to operate 
perfectly. The most important parameters for input and output configuration are also 
preset in the factory so that commissioning will be efficient. Special functions for 
online monitoring and troubleshooting complete the functional scope.

1.1	 Most important features

•	 Extremely simple parameterisation for complex applications
•	 Configurable units for country-specific adaptation
•	 Overview page for rapid entry of the most important parameters
•	 Tree view for rapid navigation through the individual configuration pages
•	 Export function for commissioning parameters
•	 Service functions for speedy troubleshooting
•	 Structured user guidance
•	 Online monitoring of main operating parameters
•	 Graphic presentation and documentation of measurement results in a .csv file 

for analysis purposes
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2	 Introduction

This manual takes you step by step through the individual functions of the SAUTER 
CASE Sensors software. Installation of the software on your PC is described, as 
well as the connection of the PC to a device via the RS485 interface. You will find 
the accessories required for these purposes in the relevant product documentation 
(PDS 32.02 and PDS 37.100) as well as in section 6 of this document.

You can find a general introduction to the topic of the demand-based ventilation 
using volume flow control in chapter 10.

2.1	 Information on use

In general, this manual gives no separate descriptions of the usual Microsoft 
Windows functions such as TAB for navigating through menus, CTRL-C for 'copy' 
or CTRL-V for 'paste', unless they can be used to carry out a special function. 
Key combination ALT-↓ can be used to open up list boxes inside combo-boxes. 
If functions can be performed with different sequences of commands, separate 
descriptions are given in each case.

In some cases, the value for a parameter can be entered on different pages. In this 
case, note that the values are automatically transferred into the other parameter 
fields, so there is no need for multiple entries.
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3	 Overview

3.1	 General configuration process

COM port test 
successful?

Communication testn
(Select and test COM port no. 

See 6.1.4
)

NO

Test points:
1. Physical connection to the device 
2. Voltage supply to the device
3. Installation of driver interface converter  
4. COM port number occupancy in the 
Windows Device Manager 

Connection type?

YES

POINT-TO-POINT 
CONNECTION

NETWORK CONNECTION

1

2

Network settings 
Search network

All devices
located?

NO

Address collision Wrong wiring

Read off additional
 information

Assign unique 
network address

Network and 
voltage supply 

pursuant to 
wiring guidelines 

YES

2

Note the network address 
of the device to be configured
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Fig. 1	 Configuration flowchart
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3.2	 Program structure
 
SAUTER CASE Sensors
- Start page
	 - I. Configure device
		  - Select device 
			   - Device category, device, network address
		  - Parameter settings
			   - Overview
				    - Project data
				    - Parameters
				    - Device information
				    - Monitoring 
					     - Status (SGU100 only)
				    - Drawings
			   - Upload from device
			   - Download to device
			   - Tools
			   - Manual operation (SGU100 only)
			   - Monitoring
	 - II. Network settings
		  - Scan network
		  - Get additional information (Read out the serial number and house 	
		    address of the device if this information was entered previously)
		  - Change address
- File
	 - Create setup protocol
	 - Import configuration
	 - Export configuration
	 - Exit
- Tools
	 - Select device
	 - Options
		  - Units
		  - Language
		  - Communication
- Help
	 - Help SAUTER CASE Sensors
	 - About
- Exit



12/75 7010081003 C

CASE Sensors



13/757010081003 C

CASE Sensors

Safety warnings

4	 Safety warnings

Never put a damaged transducer into operation. In case of doubt, please contact 
your local Sauter Service. You can find the contact address for your nearest Sauter 
representative in section 10 Customer Service or on the Internet at www.sauter-
controls.com.

•	 The EGP100 must only be used for the specified purpose: measuring differential 
pressure or air volume flow in the ventilation systems of air-conditioning plants.

•	 The SGU100 must only be used for its specified purpose: measuring the front 
sash position on a laboratory fume cupboard.

•	 The EGH681SF233 may only be used for the specified purpose, measuring the 
room temperature and the relative humidity for energy-efficient regulation of the 
room climate.

•	 The EGQ181SF203 may only be used for the specified purpose, measuring the 
air quality for energy-efficient regulation of the room climate.

•	 It is prohibited to measure explosive gases.
•	 This transducer is not approved for use in potentially explosive areas.
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5	 Installation

5.1	 System requirements

To operate the software, you need:

Hardware:
•	 Processor: Intel Pentium, 1.5 GHz or higher
•	 RAM: min. 1 GB
•	 Hard disk: min. 5 GB free memory
•	 DVD-ROM drive: for installing programs and drivers
•	 USB 2.0 connection: for interface converters
•	 Monitor resolution: min. 1024 × 768

Software:
•	 Framework: .Net Framework 4.0 or higher
•	 Database: Microsoft SQL Server Compact 3.5 Service Pack 2
•	 Supported operating systems: 

•	 Windows XP Home Premium 
•	 Windows 7 32 Bit and 64 Bit
•	 Windows 7 Starter

5.2	 Scope of delivery

One DVD-ROM with SAUTER CASE Tools installation and configuration software, 
including SAUTER CASE Sensors, CD-ROM with RS485-USB driver, .net 4.0 
Framework, SQL Server Compact, manual and Adobe Acrobat Reader for reading 
the manual.

To make the hardware connection between the transducer and the PC, you need 
additional components which must be ordered separately as applicable.

Order number Order text

0300360001 CASE Sensors incl. USB connection set

Tab. 1	 Accessories for connecting to a PC

5.3	 Software installation

Do not connect the transducer to be configured with the PC until software 
installation is complete.

NOTICE
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5.3.1	 Installation of SAUTER CASE Sensors

Parallel installations are not supported.

SAUTER CASE Sensors offers you three installation options:

•	 Stand-alone installation via a zip file. The zip file is available for downloading 
from the SAUTER Extranet, on the corresponding product pages, section 
"Software".

•	 Installation via the SAUTER CASE Tools DVD-ROM.
•	 Installation via the SAUTER CASE Suite DVD-ROM.

General installation procedure

1.	 Start the installation wizard. Carry out one of the following two steps:
•	 If you want to run the installation from the SAUTER CASE Tools or SAUTER 

CASE Suite DVD-ROM, please insert the DVD-ROM into the appropriate 
drive. The installation wizard should start automatically. If not, locate your 
DVD-ROM drive and double-click the program Setup.exe.

•	 If you want to run the installation via the zip file, first unzip the zip file and 
then double-click the program Setup.exe. 

Fig. 2	 Setup.exe in the SAUTER CASE Sensors Tools DVD

2.	 Select the language in which SAUTER CASE Sensors is to be installed. 

You can change the language at any time after installation using the menu item 
Tools → Options in the SAUTER CASE Sensors software.

3.	 Read and accept the licence agreement and click Continue.

NOTICE

NOTICE
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4.	 You can select an installation directory for SAUTER CASE Sensors in the 
next step. If you choose not to specify an installation directory SAUTER 
CASE Sensors will be installed in the standard directory C:\Program\Files\
Sauter. Click Next.

5.	 This step only applies to installation via the SAUTER CASE Tools DVD-ROM: 
Choose the tools that you want to install. You must select CASE Sensors as the 
bare minimum. Click Next. 

ÂÂ The installation program installs the software in the selected directory. 

ÂÂ After successful installation, the message Installation successfully completed 
appears.

6.	 Click Close to finish the installation procedure. 
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5.3.2	 Installation of driver for interface converter

The connection between the PC and the transducer is via the supplied USB-to-
RS485 interface. To address this via the PC, the interface converter must be set up 
on the PC you are using. The drivers you need will be found on the CD-ROM (ADA, 
USB driver software) supplied in the connection set.

The procedure for installing the drivers can be found in the enclosed instructions 
ADA-I9140, USB-to-RS-485 / RS-422 converter). The language of the instruction 
manual is English. 

When installing the drivers, follow the instructions in the instruction manual and 
if you have problems contact technical support. Contact data can be found in 
Chapter 1 “General Information”. 

Check the Device Manager as described in section 6.1.4 „Setting the COM port“ to 
see whether the drivers were properly installed.

The initial installation of a new interface converter on a PC always requires the 
installation of a new driver. We recommend that you always work with the same 
interface converter to avoid having to reinstall drivers.

NOTICE
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5.3.3	 Check installation

If the installation was successful, the SAUTER CASE Sensors configuration 
software is now available and the icon for the SAUTER CASE Sensors software is 
present on your desktop. 

1.	 Double-click on the icon to launch the software. 
ÂÂ Click on Start, Programs and select under CASE Tools the CASE Sensors 
Program.

Fig. 3	 GUI: SAUTER CASE Sensors start screen

If the start screen is not shown or if an error message appears, the installation was 
probably faulty.

2.	 Uninstall the software; see section „5.3.4 Uninstalling the software“.

3.	 Install the software again as described in section „5.3.1 Installation of SAUTER 
CASE Sensors“ . If your software installation is still unsuccessful, please 
contact your local Sauter representative for further support. You will find this 
representative in the 'Customer service' section.

4.	 After successfully installing the software, connect the necessary cable and 
interface converter to your PC as described in section „6.1 Conect the interface 
converter“.
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5.3.4	 Uninstalling the software

It may be necessary to uninstall the SAUTER CASE Sensors software because:

•	 An error occurred during the installation;
•	 The SAUTER CASE Sensors software is not working correctly and the problem 

could not be rectified;
•	 you have a more recent software version and uninstalling the old version is 

recommended;
•	 you no longer need the SAUTER CASE Sensors configuration software and you 

want to release hard disk storage.

To uninstall the SAUTER CASE Sensors software, perform these steps in order:

1.	 Remove the connected hardware components from your PC.

2.	 Close all programs that are running.

3.	 Select Start → Settings → Control Panel → Add or Remove Programs.

4.	 In the list of installed programs, find the entry for CASE Sensors and click on it.
ÂÂ In the advanced view, you will now see the 'Remove program' option.
ÂÂ After you select this option, the uninstall process will start to remove the 
SAUTER CASE Sensors configuration software from your PC.
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6 Connection and confi guration 

Before you can confi gure a transducer supported by SAUTER CASE Sensors you 
must fi rst connect and confi gure the network accessories. Furthermore common 
confi guration parameters can be set.

6.1  Connect the interface converter 

Select the appropriate cables for the connection to the PC and connect them.

EGH681
EGQ181

EGP100
ASV
FCCP
Drives

SGU100

1

3
2

CASE Sensors

1
*

)
+

!"(

&J

1

2

3

5

6

4

Fig. 4 Connection USB / RS 485 interface converter to PC

1 USB / RS 485 converter with galvanic disconnection. Connection to PC via USB 
cable.

2 Universal adaptor to connect SAUTER sensors
3 230 VAC / 24 VDC external power supply unit with audio plug
4 Slot for EGH681 and EGQ181
5 Slot for EGP100, ASV, FCCP, drives and SGU100
6 Power cable for EGP100, ASV, FCCP, drives and SGU100
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6.1.1	 Connection with an EGP100

A connection to an EGP100 is made via the SLC port on the circuit board using a 
3-pin plug. This operating mode only supports a point-to-point connection with the 
EGP100.

1

2

IP65

EN 60529

B
12

16
2

Fig. 5	 Connection with an EGP100 via 3-pin plug connection

6.1.2	 Connection to an SGU100

Connections to an SGU100 are made via terminals D+ and D- for the SLC bus 
connection.

Fig. 6	

1
3
2

1

2
3

--

D+
D-

1

Connection of SGU100 with clamp terminal

1	 Connection at slot (5), fig. 4, of the universal adapter.
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Remote access via the 3-pin plug connection on the FCCP100F0x1 is also possible 
in this operating mode.

Fig. 7 Connection with an SGU100 via 3-pin plug connection on the FCCP

6.1.3 Connection to the EGQ181 and EGH681 

EGH681
EGQ181

1

2

Fig. 8 Plug-in connector for universal adapter

The connection to the EGQ181 and EGH681 is by means of slot (1) of the 
universal adapter (2) supplied.

1. Insert the device in question to the slot (1) of the universal adapter (2).
 Â The device is connected to the universal adapter.
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6.1.4	 Setting the COM port

To connect the transducer to the PC, you have to set the correct COM port. The 
following procedure is recommended for this purpose:

1.	 Open the control panel using Start → Settings → Control panel.

2.	 Click on Control panel. Double-click on System. In the System properties 
dialogue which opens now, select the Hardware tab and click on Device 
Manager.

Fig. 9	 Windows system setting

ÂÂ It will open the overview of all available devices on your PC. The connected 
interface converter now appears under Ports (COM & LPT).
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Fig. 10	 Windows device manager

3.	 Note down the number of the COM port shown (USB Serial Port) and then start 
the SAUTER CASE Sensors tool.

4.	 In the menu bar under Tools, open the Options dialogue and select the 
Communication tab.

5.	 Set the relevant COM port via the pull-down menu.
ÂÂ For example, COM ports nos. 1, 3 and 5 are available. However, this may vary 
from one computer to another due to the individual configuration and hardware 
equipment.

Fig. 11	 Dialogue box: setting for COM port

6.	 Check the setting, as described in „6.1 Connect the interface converter“.
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7.	 Verify the communication of your connection. To do so, carry out one of the 
following two steps: 
•	 Verifying the communication of a point-to-point connection (only one device 

is connected): in the Options dialogue box click Check.
ÂÂ SAUTER CASE Sensors tries to communicate with the device and verifies 
that data can be sent and received. If communication with the device 
is successful, the system will report back the device type and firmware 
version.

•	 Verifying the communication of a network connection (a number of devices 
are connected): 
1.	 Click OK to close the Options dialogue box.
2.	 Click Configure device on the start page.
3.	 Select the device to be tested in the Select device dialogue box.
4.	 Select the option Communication address.
5.	 Enter the network address of the device that you want to verify.
6.	 Click Check

ÂÂ SAUTER CASE Sensors tries to communicate with the device and verifies 
that data can be sent and received. If communication with the device 
is successful, the system will report back the device type, the firmware 
version and the communication address.

ÂÂ If correct communication could be established, the field Communication in the 
status bar turns green.

8.	 Click OK to close the options dialogue box.

These system messages may appear:

Message Meaning / action

Identification {} successful

Identification {} with address {} 
successful

All settings are OK and parameterisation can 
proceed.

Identification failed  Error: Timeou-
tError on port COM {}

The connection settings are OK but no device could 
be found at the connection.

ff Please connect a device, check the COM port 
settings, the type of connection (point to point 
or network) or check the connection cables.

Identification failed Port Open Er-
ror on port COM  {}

1.	 Wrong COM port number selected.
ff Set the COM port number as described in 
„6.1.4 Setting the COM port“.

2.	 The COM port of your computer could not be 
addressed.

ff Another application is using the COM port 
with the selected address. Check the ad-
dresses in the Device Manager and modify 
the COM port if necessary.
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Message Meaning / action

Identification failed CrCError  for 
communication address: {}.

1.	 The connection settings are OK, but two or more 
devices are using the same connection address.

ff Check the addresses in the network settings 
and adapt the device‘s connection addresses 
so that no address is assigned twice.

2.	 The wrong connection type was selected when 
verifying communication. 

ff Verify communication as follows: 
1.	 Click Configure device on the start page. 
2.	 Select the device to be tested in the Select 

device dialogue box.
3.	 Select one of the following options:

•	 Point to point connection (PP) option if 
you have set up a point-to-point connec-
tion.

•	 Communication Address option if you 
have set up a network and additionally 
enter the network address of the device 
you want to check.

4.	 Click Check

Identification failed TimeoutError 
for communication address {}.

The connection settings are correct, however no 
device corresponding to the selected address has 
been found. Please check that this address exists: 
1.	 Click on Network settings on the start page
2.	 Click on Scan network to find the devices con-

nected to the network. 
3.	 Note the communication address of the device to 

configure 

Tab. 2	 System messages, connection test
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6.2	 Ending the configuration

Disconnect the transducer from the PC when parameterisation is complete. Make 
sure you close the transducer's cover to reinstate IP protection.

B
12

16
3

2

1 IP65

EN 60529

Fig. 12	 Separating the connection between EGP100 and PC (connection via 3-pin plug 
connection)

B
12

16
4

Fig. 13	 Separating the connection between SGU100 and PC (connection via terminal 
block)
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Fig. 14 Separating the connection between SGU100 and PC (connection via 3-pin plug 
connection on the FCCP)

EGH681
EGQ181

1

2

Fig. 15 Separating the connection between EGQ181SF203 and universal converter, 
separating the connection between EGH681SF233 and universal converter

Pull the device (1) out of the slot of the universal converter (2).
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6.3	 Extras

6.3.1	 Select communication address

You can establish a connection to the device of your choice. This can be useful if 
you want to:

•	 Read the parameters of a device located in the network
•	 Adopt parameters that are identical for all devices for each device

The network address that you have entered always refers to the device type 
displayed in the information bar. To communicate with the network address of a 
different device type, you must first enter the device type. To do so, click Configure 
device on the start page.

Carry out the following steps in order to establish communication with a device:

1.	 Select the menu item Tools → Select Address

2.	 Select one of the following options:
•	 Select the Point to point connection (PP) option if you want to set up 

connection to a device in a point-to-point scenario.
•	 Select the Individual address option and additionally enter the network 

address of the device if you want to establish communication with a device in 
a network.

3.	 Click on OK.
ÂÂ SAUTER CASE Sensors establishes communication with the selected network 
address or device. 

Fig. 16	 Dialogue box: Select communication address

NOTICE
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6.3.2 Options 

You can make country-specifi c adjustments and set the COM port via the menu 
item Tools → Options.  

6.3.2.1 Units 

On the Units tab, you can adjust the units to be used by the software to your 
personal circumstances.

Fig. 17 Dialogue box: Options → Units

The following options are available here.

Physical unit Units

Length mm, inch, ft

Adjustable units

Cross-section m2, inch2, ft2

Pressure Pa, mpsi

Volume fl ow m3/h, l/s, cfm, cim

Density kg/m3, pci, pcf

Temperature °C, °F, K

Relative humidity % rh

Specifi ed units

Absolute humidity g/kg

Enthalpy kJ/kg

CO2 ppm

VOC % IAQ

Tab. 3 Adjustable and fi xed units
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6.3.2.2 Language  

The Language settings tab enables you to change the program language. You can 
choose between English, French and German. 

Fig. 18 Dialogue box: Options → Language

6.3.2.3 Communication  

The Communication tab shows the available COM ports. Here you can enter the 
COM port number that SAUTER CASE Sensors should use to communicate with 
the devices and verify point-to-point communication. Set the COM port number as 
described in „6.1.3 Setting the COM port“ .

Fig. 19 Dialogue box: Options → Communication
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7	 User interface

The program is designed so that simple and structured user guidance is ensured. 
After starting the program, the Start page is called. This page is used to call up the 
configuration items for Network settings and to enter the device configuration, 
Configure device.

Fig. 20	 GUI: SAUTER CASE Sensors start page
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7.1	 General structure of the user interface (example: SGU100)

1

2

4

6

5

3

7

Fig. 21	 GUI: User interface, SAUTER CASE Sensors

1 Menu bar

2 Navigation tree

3 Input mask

4 Information line

5 Navigation bar

6 Upload and download control

7 Service functions

The user interface is divided into different areas. Basically, these can be separated 
into the information and navigation areas, and the areas for data entry.

The menu bar contains basic functions for parameter printing or application 
configuration and to provide information about how the individual functions work. 
The product documentation can also be accessed from the Help area.

The navigation tree shows all the pages that are available to configure the volume-
flow compact controller in a clear form. Click on the relevant page to activate it.

The parameters for the transducer are entered via the input mask.

The information line and status bar provide the most important data about the 
connected volume-flow compact controller in a clear form.

Navigation buttons in the navigation bar allow you to move between the Start page 
and the area for device parameterisation.

Menu bar

Navigation tree

Input mask

Information line

Navigation bar
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In this section you can read out the parameterisation data from the device (upload 
from the device) or write them to the device (download to the device).

Special functions such as sensor calibration, manual mode or online monitoring to 
support commissioning are provided in the service area.

Upload and download 
control

Service functions
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8 Parameterisation 

The following section gives a step-by-step description of the functions available 
within the SAUTER CASE Sensors software to parameterise a transducer volume-
fl ow compact controller. Before parameterisation, an transducer must fi rst be 
physically connected and confi gured as described in section 5.

8.1 Starting the program 

1. Start the program from the Start menu Start → Programs → CASE Tools or 
CASE Suite → CASE Sensors in order to start it.

 Â A Welcome screen appears briefl y at fi rst, and then the Start page is displayed.

8.2 Start page 

The following functions are available for you to choose from the Start page.

Icon Function Description

Device confi guration Click on the function to confi gure a device that is not 
yet confi gured, or to change the confi guration of a 
parameterised device. Directly after the overview page 
appears, you can select the Upload from device func-
tion to do this; the data stored in the device will then 
be loaded. After selecting the function, the Parameter 
settings – Overview page is shown.

Network settings The Network settings can be used to read in a section 
of the network automatically in order to determine 
which devices are available in the network segment. 
In the event of an address collision, it is possible to 
confi gure the network addresses in the Network set-
tings area.

Exit Select this function to end the program.

Tab. 4  Start Page functions

When the SAUTER CASE Sensors program is closed, all the data that was entered 
are lost. If you want to save data for later confi gurations of other devices, you can 
use a transducer by downloading all the data into it and then restoring this data for 
use at a later stage in the program by uploading it.
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8.3	 Export configuration

You can export and save the configuration of the transducer to a file to back up the 
device configuration or to document the project. When you do so, you can choose 
which configuration data you want to save (the default selection is all data):

•	 Project information
•	 Parameters

Carry out the following steps to export the data to a file:

1.	 Select File → Export configuration.

2.	 You can add a description of the export file in the Description and the Name 
fields to enable unambiguous identification. The default name consists of the 
device type. 

3.	 Click Browse and select the directory where you want to save the file. Change 
the file name if needed.

4.	 Click Details if you want to select individual data for export. The default setting is 
to export all of the data in a file. 

5.	 Click Export to export the selected data to a file.

8.4	 Import configuration

The Import configuration function allows you to import the configuration from a file 
into SAUTER CASE Sensors. This function can be useful for uploading or restoring 
a previously-saved device configuration, for instance.

Note: To avoid conflicts between the device type and the configuration file selected 
in CASE Sensors, it is advisable to import a configuration file from the home page.

Carry out the following steps to import a configuration into CASE Sensors: 1.

1.	 Select File → Import configuration.

2.	 Click Browse to locate the directory where the file is archived. 

3.	 In the Select file table, select the line with the file that you want to import.

4.	 Click Details if you want to select individual data for import. The default setting is 
to import all of the data in a file. 

5.	 Click Import to import the selected data to CASE Sensors.
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8.5	 Print configuration

This function is not available on the sensors EGH681SF233 and EGQ181SF203. 

All configuration data can be printed to a file using the Print function: go to the File 
menu Create set-up protocol. After calling up the function, you first see an input 
dialogue where you can add a comment.

Fig. 22	 Dialogue box: Print configuration

Confirm the dialogue with OK and the protocol is generated, with all the available 
data. To store or continue processing the data, or to print them out later on, you are 
offered a large number of different formats.
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8.6	 Network settings

In the Network Settings function, the devices connected in the network are shown 
and configured if necessary.

Fig. 23	 GUI: Network settings

To configure connected devices, you must first click on the Scan network button to 
start a search. To do so, carry out the following steps:

1.	 Select Network Settings on the start page.

2.	 Click Scan network. 
ÂÂ The program then checks whether there are any devices in the network and 
lists them in table form, after a timeout of 30 s. at most. During the search, 
the searched address appears in the Current address field with the network 
address of the device in the list.

3.	 Once all the devices in the network segment have been listed, you can terminate 
the search by clicking Abort.

The following information is shown:

Parameters Description

Communication ad-
dress 

On delivery, every device has been given an individual network 
address in the range from 1….200. This could be modified manu-
ally if necessary.

Change address Click on the address shown to reconfigure it in the menu.

Collision If two or more devices attempt to communicate on one address, 
there will be an 'address collision'. This is shown by a red symbol.
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Parameters Description

Device type The device type is shown as per the labelling on the nameplate

House address The house address is shown, if it is parameterised. The house 
address is displayed after pressing the Get additional information 
button.

Serial number The serial number uniquely identifies a particular device. It is 
issued by the factory. On clicking the Additional information but-
ton, it is read in via the network.

Tab. 5	 Parameters for network configuration

If a device is explicitly selected, you can press the Change address button to call 
up the Change communication address dialogue.

Fig. 24	 Dialogue box: Change address

The following options are available:

•	 If only one device is connected, it is mandatory to select the Point to point 
connection (PP) function. The volume-flow compact controller is then 
addressed directly.

•	 If two or more devices are present in the network, the address of the desired 
device must be selected via the Communication address function.

•	 If you know the device's serial number you can enter it into the field Serial 
number. This enables you to differentiate between two devices with the same 
address (collision) and to assign a new address to one of the two devices 
without having to disconnect it from the network.

•	 The New address function allows manual assignment of a new network 
address. This may be selected from the 1…200 range.
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8.7	 Configure device 

To configure a new device, please select the Configure device menu item. You can 
then select the device you want to configure. To do so, first select the category and 
then the device. 

Allocation of devices to device categories and device descriptions: 

Device category Device Description 

Differential pressure trans-
ducer

EGP100F102/F112 Measurement range: ±75 Pa
Characteristic curve: linear

EGP100F202/F212 Measurement range: ±150 Pa
Characteristic curve: linear

EGP100F302/F312 Measurement range: 0…150 Pa
Characteristic curve: linear or 
square root

EGP100F402/F412 Measurement range: 0…300 Pa
Characteristic curve: linear or 
square root

Sash sensor SGU100F010/F011 Max. spring stroke: 
F010: 0…1000 mm 
F011: 0…2000 mm

Air quality sensor (VOC) EGQ181SF203 Measurement range: 0...100 % 
IAQ (indoor air quality)

Humidity and temperature 
transducer

EGH681SF233 Measuring ranges:
Temperature 0...50 °C
Relative humidity 0...100% rh

Calculated variables:
Absolute humidity 0...50 g/kg
Dew point -5...30 °C
Enthalpy 0...100 kJ/kg

Tab. 6	 Supported devices in SAUTER CASE Sensors V2.2

Make sure you select the correct device. An incorrect assignment can cause an 
error message when downloading the parameters into the device, because the 
software does not allow parameterisation of devices with values that do not match 
the sensor's measuring range.

Fig. 25	 Dialogue box: Device selection

NOTICE
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In the Communication address area, you can select the Point to point connection 
(PP) or Individual address functions. The individual address can be determined in 
the Network settings area. After setting the address, you can test communication 
with the Check button.

If only one device is connected, the Point-to-point function must be selected.

If more than one device is present in the network, the PP connection function must 
not be used. The valid address in each case must be set at Individual address so 
that the desired device is addressed directly.

8.8	 Parameter settings

Once you have selected a device you will see the Parameter settings page.

The available functions relating to Parameter settings are described in the 
following sections. You can navigate through the various parameter setting options 
using the navigation tree on the left. The service functions are located to the right of 
the user interface.

8.8.1	 Overview

The most important parameters for configuring the transducer are bundled together 
and accessible in the Overview section.

All the parameters provided on this page can be reached on the respective detail 
pages, via the navigation tree. However, they only need to be entered once. 
The program automatically copies the parameters. For the same reason, these 
parameters are also described twice in the manual, with more in-depth information 
on the detail pages as necessary or appropriate.

8.8.2	 Project data

You can enter the house address for unique transducer localisation and the date of 
commissioning in the Project data section. 

Parameters Description

Plant device identifica-
tion

Enter the transducer's plant device identification. You can enter 
a maximum of 12 characters. This information is also recorded 
in the Set-up protocol.

Commissioning date Enter the date on which the plant was commissioned. The 
date must have the format YYY/M/D. This information is also 
recorded in the Set-up protocol.

Tab. 7	 Parameter input in the “Project data” section
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8.8.3	 Parameters

In the Parameters section you can enter the parameter settings for the 
measurement signal, the characteristic curve and the device's special functions. 
The parameters available here are dependent on the transducer. You can find a 
device-specific description of the available parameters in chapter „9 Device-specific 
parameterisation“.

8.8.4	 Device data

The transducer's identification details for support purposes are displayed in the 
Device data section:

Parameters Description

Device 
EGQ181 / EGH681

Unique parts no. of device. 
EGH681SF233 or EGQ181SF203

Serial number  
EGQ181 / EGP100 / 
SDX100 / EGH681 /
SGU100 /

Unique device number, assigned during manufacture of the 
volume-flow compact controller and used for tracing back to 
production.

Production date 
EGQ181 / EGP100 / 
SDX100/ EGH681 / 
SGU100

Production date of the transducer.

Plant calibration 
EGQ181 / EGP100 / 
SDX100/ EGH681 / 
SGU100

Date and time an which the transducer was calibrated in the 
factory.

Measuring range  
EGP100 / SDX100

Measurement range (fs) in Pa of the differential pressure trans-
ducers in use.

Firmware data EGP100 / 
SDX100 / SGU100

Factory code consisting of the device type and firmware version

Tab. 8	 Parameter device information

8.8.5	 Monitoring

In the Monitoring area, the measured values are displayed graphically and 
numerically. Before you start a visualisation, we recommend you read out the 
device's current configuration via an upload.
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Fig. 26 Graphical and numerical display using the example of EGH681

To display the values in the area Current values and start a visualisation, click 
Start monitoring in the right-hand column of the GUI in the Monitoring area.

You can display the measurement values for two transducers in parallel. To do 
so, you must select a second transducer (sash sensor or differential pressure 
transducer) by entering the network address and selecting the device type (F 
variant). Simultaneous visualisation of two transducers allows you to collect 
valuable information and correlations relating to the following processes during 
commissioning:

•	 Duct pressure or volume fl ow control for supply and return air
•	 Fluctuations in room pressure in relation to fl uctuating supply or return air 

pressure 
•	 Variations in room pressure and return air fl ow in a laboratory when opening or 

closing a laboratory fume cupboard

To visualise a secondary device, select the option Visualize a second device in 
the section Graph settings.

It is not possible to visualise two transducers for a point-to-point connection.

Adjust the settings for the visualisation display in the Graph settings section.

You can adjust the colour for the displayed parameters of a device under First 
device. You can also defi ne the parameter colours for a second controller if you 
have selected the option Visualize a second device. 

NOTICE
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You can adjust the time interval for recording measurement values under 
Timing settings. The number of entries is limited to 32,000.

You can save the graphic data in a .csv file under Log settings and use the data 
for further plant diagnosis purposes.

The Monitoring section has an additional sub-section named Status for SGU100 
sensors. It is used to display operating, error and maintenance statuses for the 
SGU100. Further information is available under „9.2.4 Status display“.

The following additional functions are also available for the visualisation display:
•	 Zoom-in/zoom-out: Left-click in the visualisation area and simultaneously scroll 

with the mouse. 
•	 Editing the visualisation: Right-click in the visualisation area. You have the 

following options:
•	 Copy: Copy the visualisation to the clipboard.
•	 Save Image As: Save the current visualisation to a data carrier. 
•	 Page Setup: Show the print settings for the visualisation.
•	 Print…: Print the visualisation (with prior selection of the target 

printer). 
•	 Show Point Value: Hover the mouse cursor over a curve to display 

the measurement values. 
•	 Un-Zoom: Zoom out one level.
•	 Undo all Zoom/Pan: Restore the original size of the visualisation and 

scale after zooming.
•	 Set scale to default: Display recorded measurement values over the 

entire recording period.

8.9	 Diagrams

The Diagrams area is purely for information purposes and is intended to give on-
the-spot support for installation or troubleshooting. The diagrams shown indicate 
the control signal flow in the application and the assignment of cable connections 
(Wiring diagram).

NOTICE
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9	 Device-specific parameterisation

This section describes device-specific parameter settings and service functions 
under Start page → Configure device.

9.1	 Differential pressure transducer EGP100

9.1.1	 Adjustable device parameters 

You can set the measurement range and the analogue output for the EGP100.

Fig. 27	 GUI: Parameters for an EGP100 with a symmetrical measurement range

Fig. 28	 GUI: Parameters for an EGP100 with an asymmetrical measurement range
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Parameter settings in the Measurement section

Parameters Description

Gain ∆P Sets the amplification for measurement range adjustment. The 
amplification ∆P value can be set from 1 to 3.

Formula:

Values for ∆Pmax sensor see Tab. 6.

Gain volume flow (only 
for F3xx and higher) 

Displays volume flow amplification. 

Formula:  

Offset Displays the sensor's zero point drift in Pa. Zero point drift is 
only recalculated in the event of zero point balancing.

Damping Measurement signals subject to significant fluctuation or elec-
tronic
interference can be attenuated using an adjustable damping 
time constant. 

Setting range:
•	 0.000 s
•	 0.010 s
•	 0.020 s
•	 0.041 s
•	 0.082 s
•	 0.163 s
•	 0.326 s
•	 0.650 s
•	 1.300 s
•	 2.600 s
•	 5.220 s

Increasing the time constant filters heavily fluctuating signals; 
the measurement signal will, however, become more sluggish 
in the event of pressure variations.

Tab. 9	 EGP100 parameters: Measurement
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Parameter settings in the Analogue output section

Only the differential pressure (linear characteristic curve) is detected for systems 
with a symmetrical measurement range (F1xx and F2xx).

Parameters Description

Pressure (only for F3xx 
and higher)

Select the Pressure option if you want to measure the pres-
sure (linear characteristic curve).

Flow (only for F3xx and 
higher)

Select the Flow option if you want to measure the volume flow 
(square root characteristic curve).

Mode Setting the voltage range for the analogue output. 

Select one of the three options:
•	 0…10 V = 0…100 %
•	 2…10 V = 0…100 %
•	 Free configurable: enter the Start and Final points of the 

measurement value and the output voltage in the field Start 
and End to set the transducer‘s characteristic curve. The 
maximum output voltage for an EGP100 is 10.5 V.

The % values relate to the values displayed in the field Current 
measurement range.

Tab. 10	 EGP100 parameters: Analogue output

Parameter settings in the Parameter date section

Parameters Description

Parameter date Date and time of the last download are set automatically and 
stored. The data is taken from the PC which the program is 
installed on.
If no download has been carried out the system will display 
the date and time when the Parameter settings function was 
called up.

Tab. 11	 EGP100 parameters: Parameter date

NOTICE
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9.1.2	 Application examples

Application example 1: Volume flow measurement

Specifications:

•	 Maximum volume flow in the plant: 1150 m3/h
•	 Ventilation duct diameter: DN = 250
•	 Volume flow of the measurement device: XAFP100F001 in combination with 

EGP100
•	 Air density: 1.2 kg/m3

ÂÂ Calculation of the resulting differential pressure in accordance with:

•	 C-factor (in accordance with the installation instructions for the flow sensor 
XAFP100, document number: P100003790) = 154.6

•	 Differential pressure measured at 1150  m3/h: ∆P = 55 Pa

ÂÂ Device selection: EGP100F302 or EGP100F312 ( ∆Pmax sensor = 150 Pa)

Parameter settings for EGP100F3x2:

•	 Gain ∆P = 2.5 (current measurement range = 0…60 Pa) 
•	 Analogue output: 0…100 % = 0…10 V or 2…10 V 

The analogue signal relates to the new measurement range setting 0…60 Pa, i.e. 
100% of the set measurement range equates to 60 Pa. The resulting volume flow 
when taking the C-factor into account is 1200 m3/h.

The output signal on devices whose measurement input is not adequately 
"sinkable" should parameterised at 2…10 V. This will prevent errors in the lower 
measurement range area.

NOTICE
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Application example 2: Differential pressure measurement

Specifications:

•	 Maximum differential pressure in the plant: 200 Pa

ÂÂ Device selection: EGP100F402 or EGP100F412 (∆Pmax sensor = 300 Pa)

Parameter settings for EGP100F4x2:

•	 Gain ∆P = 1.5 (current measurement range = 0…200 Pa) 
•	 Analogue output: 0…10 V = 0…100 % or 2…10 V = 0…100 %

The output signal now relates to the new measurement range setting 0…200 Pa.

•	 You will need to reduce the gain ∆P to measure values greater than 200 Pa.
•	 The output signal on devices whose measurement input is not adequately 

"sinkable" should parameterised at 2…10 V. This will prevent errors in the lower 
range area.

9.1.3	 Service functions

The following functions are available in the right-hand column under Configure 
device for commissioning and servicing an EGP100:

•	 Zero point adjustment: Mouse-click on the Zero point adjustment button 
to force a sensor adjustment. First, you see a window indicating that the two 
measuring connections must be removed. After confirming with OK, a sensor 
adjustment is performed. Only the zero point of the sensor is reset in this case, 
i.e. the offset of the sensor is changed. This procedure is not a calibration.

•	 Current values

The measured differential pressure is displayed numerically in the Current values 
section in Pa and as a percentage of the current measurement range. 

Click on Start monitoring to update the values.

These measurement values are also displayed graphically in the Monitoring 
section in the form of a bar chart. You can also save a historic record of 
measurement values in the form of a .csv file. 

Further information about the Monitoring is available under „8.6.5 Monitoring“.

NOTICE

NOTICE
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9.2	 Sash sensor SGU100

9.2.1	 Adjustable device parameters

The SGU100 allows you to set the sensor, the acoustic signal and the analogue 
output.

Fig. 29	 GUI: Parameters SGU100

Parameter settings in the Sensor section

Parameters Description

Damping Measurement signals subject to significant fluctuation or elec-
tronic
interference can be attenuated using an adjustable damping 
time constant. 

Setting range:
•	 0.000 s
•	 0.010 s
•	 0.020 s
•	 0.041 s
•	 0.082 s
•	 0.163 s
•	 0.326 s
•	 0.650 s
•	 1.300 s
•	 2.600 s
•	 5.220 s

Increasing the time constant filters heavily fluctuating signals; 
the measurement signal will, however, become more sluggish 
in the event of pressure variations.

Tab. 12	 SGU parameters: Sensor
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Parameter settings in the Buzzer-Settings section 

All acoustic signals are activated by default.

Parameters Description

Fault state Alarm indication in the event of the following faults: The fault 
states are:
•	 Supply voltage too low
•	 Measurement error

Sensor overridden by 
communication

Alarm indication if the measurement signal is overridden. This 
is only possible in manual operating mode. In this case the 
value measured at the transducer's analogue output is overrid-
den by a specified value. Override can be used for test pur-
poses and indicated by an acoustic signal.

Uninitialised sensor Alarm indication if the SGU100 is not initialised and valid teach-
in values are therefore not available. For more information on 
the teach-in process see „9.2.3 Service functions“.

Teach in mode Alarm indication during the teach-in process after completion 
of the following teach-in phases (for successful or unsuccessful 
completion):  
•	 Front sash closed (measurement of start position, P1)  
•	 Position change  
•	 Sash open (measurement of nominal position, P2) 

Tab. 13	 SGU parameters: Buzzer-Settings

You can find a detailed list of the acoustic and visual signals of the SGU100 in the 
SGU100 product data sheet (PDS37.100) in the "Signalisation" section.

Parameter settings in the Analogue outputsection 

Parameters Description

Mode Sets the voltage range of the analogue output in dependence 
on the teach-in range. 
The teach-in range relates to the sash stroke between start 
position and nominal position or between 0% and 100%. Select 
one of the three options:
•	 0…10 V = 0…100 % 
•	 2…10 V = 0…100 % (factory setting)
•	 Free configurable: you can set the output voltage between 

0 and 11.5 V in accordance with the teach-in range.

Start position Defines the position at which the sash is closed, i.e. has trav-
elled 0% of the teach-in range.

Nominal position Defines the position at which the sash is open, i.e. has travelled 
100% of the teach-in range.

Tab. 14	 SGU parameters: Analogue output

You can find further information on the teach-in range in the product data sheet for 
the SGU (PDS 37.100) in the "Function diagram" section.

NOTICE

NOTICE

NOTICE
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Parameter settings in the Parameter date section 

Parameters Description

Parameter date Date and time of the last download are set automatically and 
stored. The data is taken from the PC which the program is 
installed on. If no download has been carried out the system 
will display the date and time when the Parameter settings 
function was called up.

Tab. 15	 SGU parameters: Analogue output

9.2.2	 Application examples

Application example: Measurement of the sash position on a bench-mounted fume 
cupboard

Specifications:

•	 Maximum permissible open range of the sash: 500 mm

ÂÂ Device selection: SGU100F010 (max. stroke 1000 mm)

Parameter settings for the SGU100F010:

•	 Analogue output: 2…10 V = 0…100 % 
•	 Implementation of the teach-in process: device learns the start position (sash 

closed) and the nominal position (sash opened to 500 mm). You can carry out 
the teach-in process by clicking on Teach in positions see „9.2.3 Service 
functions“.

The analogue output signal 2...10 V relates to the new teach-in range setting. This 
means that the output signal is 2 V when the sash is closed; when the sash is open 
(500 mm) the output signal is 10 V. The excess-stroke alarm signal of the SGU100 
will trigger if the maximum permissible opening range is exceeded.

9.2.3	 Service functions

The following service functions for commissioning and servicing the SGU100 are 
available under Configure device in the right-hand column:

•	 Teach in positions
•	 Manual operation
•	 Current values
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Teach in positions

ff Click on Teach in positions to start the teach-in process. SAUTER 
CASE Sensors will guide the user through every step of the process.

ÂÂ A message appears at the end of the teach-in process to confirm the SGU100 
has learned each position correctly. 

You can also start and carry out the teach-in process by pressing the internal or 
external button on the SGU100. You can find a general description on how to carry 
out the teach-in process in the product data sheet for the SGU100 (PDS 37.100) in 
the section "Adapting the operating range (Teach in)". 

Manual operation

You can enter a value to override the current measurement value at the sash 
sensor's analogue output by clicking on Manual operation. This function is 
required for testing and inspection purposes. You can, for instance, test the volume 
flow control of the fume cupboard without having to open or close the sash by 
entering an output value for the SGU100.

Fig. 30	 Dialogue box: SGU100 Manual operation active

NOTICE
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Activating manual operation:

1.	 Select the option On in the Manual operation dialogue box.

2.	 Enter the analogue output value.

3.	 Click on the button Set mode. 
ÂÂ The status and the active output voltage are displayed in the field Currently 
selected of the dialogue box and in the right-hand column of the service 
functions. The Communication field in the status bar is green when manual 
operation is active.

Deactivating manual operation: 

Manual operation will be deactivated if you 

•	 select the Off option in the Manual operation dialogue box and then click on 
Set mode, 

•	 close CASE Sensors, or
•	 communication with the device is interrupted.

If you have selected the option "activated" in the Manual operation field under 
Buzzer-Settings, the SGU100 will emit an acoustic signal when manual operation 
is activated.

Current values

The currently measured sash position is displayed as a numerical value in the 
section Current values. 

ff Click on Start monitoring to update the values.

These measurement values are also displayed graphically in the Monitoring 
section in the form of a bar chart. You can also save a historic record of 
measurement values in the form of a .csv file.

Further information about the Monitoring is available under „8.8.5 Monitoring“.

NOTICE

NOTICE
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9.2.4	 Status display

You can call up the current operating, fault and services statuses of an SGU100 in 
the Status section of the Monitoring. 

ff To update the display, click on Start monitoring in the Current values section of 
the right-hand column on the GUI.

ÂÂ A tick in the Status column indicates the current status of the SGU100.   

Parameters Description

Operation states

Factory Matches delivery status.

Normal The transducer is ready for operation.

Manual Manual operation is active.

Teach in Teach-in process is active (see also „9.2.3 Service functions“)

Teach in start  
position

Device learns the start position (front slider closed) during the 
teach-in process.

Teach in waiting Temporary phase following the teach-in phase. During this phase 
(max. 60 seconds) you can place the sash in its nominal position. 
The SGU100 will remain in the paused teach-in phase whilst 
you position the sash. 

Teach in nominal 
position

Device learns the nominal position (front slider open) during the 
teach-in process.

Teach in button is 
pressed

The teach-in button on the SGU100 was pressed

External alarm signal Overstroke alarm contact was triggered.

Overstroke detected Overstroke alarm contact was triggered. This means that the 
nominal position was exceeded.

Fault states

Data storage The process of writing measurement values to a file was inter-
rupted.

Measurement A measurement error has occurred if the internal measured 
values are outside the expected range. Possible reasons for this 
include:
•	 Internal error in sensor caused by a shock
•	 The maximum spring stoke has been exceeded or the mini-

mum spring stroke has not been reached
•	 Electrical interference by an external source

Teach in The teach-in process was not completed successfully or there are 
no valid teach-in values in the SGU100.

Low voltage The voltage supply to the SGU100 is insufficient.

Maintenance states

Teach in positions Device learns the position during the maintenance states.

Tab. 16	 Operation, fault and maintenance states of the SGU100
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9.3 Room humidity and temperature sensor EGH681

9.3.1 Adjustable device parameters

In the case of the EGH681, you can carry out settings for the following parameters:

•	 Humidity measurement
•	 Temperature measurement
•	 Humidity output
•	 Temperature output
•	 LED

Fig. 31 GUI: EGH681 parameters
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Parameter settings in the Humidity Measurement area

Parameters Description

Limit setting The limits can be set individually. 
The LED indicator on the sensor visualises:
•	 that the limit value has been exceeded
•	 that the limit value has not been reached
•	 the optimum value

Measured value < 1  ; LED signal = red

Measured value >       < 2  ; LED signal = yellow

Measured value > 2  < 3  ; LED signal = green

Measured value > 3  < 4  ; LED signal = yellow

Measured value > 4  ; LED signal = red

Tab. 17	 EGH parameters: Humidity measurement

Parameter settings in the Temperature measurement area

Parameters Description

Limit setting The limits for temperature measurement can be set individually.
The LED indicator on the sensor visualises:
•	 that the limit value has been exceeded
•	 that the limit value has not been reached 
•	 the optimum value

Measured value < 1  ; LED signal = red

Measured value > 1  < 2  ; LED signal = yellow

Measured value > 2  < 3  ; LED signal = green

Measured value > 3  < 4  ; LED signal = yellow

Measured value > 4  ; LED signal = red

Tab. 18	 EGH parameters: Temperature measurement

Parameter settings in the Output area.  
The EGH681 has two analogue outputs that can be configured according to 
individual requirements. 

Parameters Description

Main sensor

Setting analogue out-
puts

The following variables can be selected:
•	 Deactivated 
•	 Temperature
•	 Relative humidity
•	 Absolute humidity
•	 Dew point
•	 Enthalpy

Set the voltage range of the analogue outputs.

Select one of the three options:
•	 0…10 V= 0…50 °C (sample variable: temperature)
•	 2…10 V= 0…50 °C (sample variable: temperature)
•	 Freely configurable: To set the characteristic curve of the 

transducer, proceed as follows: 
In the “Conversion table” area, enter the starting and end 
points of the measured value and the output voltage in the 
fields Start and End. 

Tab. 19	 EGH parameters: Analogue outputs

1
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Parameter settings in the LED area

Parameters Description

LED function You can assign the following functions to the LED indicator of 
the sensor:
•	 Deactivated
•	 Humidity monitoring
•	 Temperature monitoring
•	 Humidity and temperature monitoring

Tab. 20	 EGH parameters: LED

9.3.2	 Service functions

Before commissioning the EGH681, start monitoring to check the function of the 
sensor.

In the Monitoring area in the right-hand column, all measured values are shown 
graphically in the form of a bar chart as well as numerically. Before you start a 
visualisation, we recommend you read out the device's current configuration via an 
upload.

1.	 To do so, click the Upload from device button.

2.	 Click on Start monitoring to update the values.

These measurement values are also displayed graphically in the Monitoring 
section in the form of a bar chart.. You can also save a historic record of 
measurement values in the form of a .csv file.

Further information about the Monitoring is available under „8.8.5 Monitoring“.

NOTICE
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9.4 Air quality sensor (VOC) EGQ181

9.4.1 Adjustable device parameters

In the case of the EGQ181, you can carry out settings for the following parameters:

•	 VOC measurement
•	 VOC output
•	 LED

Fig. 32 GUI: EGQ181 parameters

Parameter settings in the VOC Measurement area

Parameters Description

Limit setting The limits for VOC measurement can be set individually.
The LED indicator on the sensor visualises:
•	 that the limit value has been exceeded
•	 that the limit value has not been reached 
•	 the optimum value

Measured value < 1  ; LED signal = green

Measured value > 1  < 2  ; LED signal = yellow

Measured value > 2  ; LED signal = red

Tab. 21 EGQ parameters: VOC measurement
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Parameter settings in the VOC output area

Parameters Description

VOC output Set the voltage range of the analogue output.

Select one of the three options:
•	 0…10 V= 0…100 %IAQ
•	 2…10 V= 0…100 %IAQ
•	 Freely configurable: To set the characteristic curve of the 

transducer, proceed as follows: 
In the “Conversion table” area, enter the starting and end 
points of the measured value and the output voltage in the 
fields Start and End. .

Tab. 22	 EGQ parameters: VOC output

Parameter settings in the LED area

Parameters Description

LED function You can assign the following functions to the LED indicator of 
the sensor:
•	 Deactivated
•	 VOC monitoring

Tab. 23	 EGQ parameters: LED

9.4.2	 Service functions

Before commissioning the EGQ181, start monitoring to check the function of the 
sensor.

In the Monitoring area in the right-hand column, all measured values are shown 
graphically in the form of a bar chart as well as numerically. Before you start a 
visualisation, we recommend you read out the device's current configuration via an 
upload.

1.	 To do so, click the Upload from device button.

2.	 Click on Start monitoring to update the values.

These measurement values are also displayed graphically in the Monitoring 
section in the form of a bar chart.. You can also save a historic record of 
measurement values in the form of a .csv file.

Further information about the Monitoring is available under „8.8.5 Monitoring“.

NOTICE
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10	 Customer service

Address of your local SAUTER service points in Europe:

SAUTER Schweiz
Sauter Building Control Schweiz AG
Kägenstrasse 17
CH-4153 Reinach
Tel. +41 61 717 75 75
Fax +41 61 717 75 00

SAUTER Deutschland
Sauter-Cumulus GmbH
Hans-Bunte-Strasse 15
DE-79108 Freiburg i. Br.
Tel. +49 761 510 50
Fax +49 761 510 52 34

SAUTER France
Sauter Régulation S.A.S.
30 Rue Marc Seguin - B.P. 2059
FR-68059 Mulhouse Cedex
Tel. +33 3 89 59 32 66
Fax +33 3 89 59 40 42

SAUTER Ibérica
Sauter Ibérica S.A.
Jacint Verdaguer, 34-38
ES-08902 L'Hospitalet (Barcelona)
Tel. +34 93 432 95 00
Fax +34 93 432 09 08

SAUTER Österreich
Sauter Mess- u. Regeltechnik GmbH
Niedermoserstrasse 11
AT-1222 Wien
Tel. +43 1 250 230
Fax +43 1 259 95 35

SAUTER U.K.
Sauter Automation Ltd.
Inova House Hampshire
Int'l Business Park
Crockford Lane, Chineham
UK-Basingstoke RG24 8WH
Tel. +44 1256 37 44 00
Fax +44 1256 37 44 55

SAUTER Italia
Sauter Italia S.p.A.
Via Natale Battaglia 40
IT-20127 Milano
Tel. +39 02 280 481
Fax +39 02 280 482 80

SAUTER Nederland
Sauter Building Control Nederland B.V.
Gyroscoopweg 144a
P.O. Box 20613
NL-1001 NP Amsterdam
Tel. +31 20 5876 701
Fax +31 20 5876 769

Sauter Building Control International GmbH
Hans-Bunte-Strasse 15
DE-79108 Freiburg i. Br.
Tel. +49 761 510 50
Fax +49 761 510 52 34

SAUTER Belgium
N.V. Sauter Controls S.A.
't Hofveld 6-B-2
BE-1702 Groot Bijgaarden
Tel. +32 2 460 04 16
Fax +32 2 460 58 97

SAUTER Magyarország
Sauter Automatikai Kft.
Fogarasi u. 2 - 6.III. em.
HU-1148 Budapest
Tel. +36 1 470 1000
Fax +36 1 467 9000

SAUTER Srbija
Sauter Building Control Serbia doo
Alekse Nenadovica 15
SRB-11000 Belgrad
Tel. +381 1 1383 5571
Fax +381 1 1245 2260

SAUTER Ceská republika
Sauter Automation Spol. s.r.o.
Pod Cimickým hájem 13 a 15
CZ-18100 Praha 8
Tel. +42 02 660 12 111
Fax +42 02 660 12 221

SAUTER Polska
Sauter Automatyka Sp. z o.o.
Ul. Postępu 1
PL-02-676 Warszawa
Tel. +48 22 853 02 92
Fax +48 22 853 02 93

SAUTER Sverige
Sauter Automation AB
Krossgatan 22B
SE-16250 Vällingby
Tel. +46 8 620 35 00
Fax +46 8 739 86 26

SAUTER Slovensko
Sauter Building Control Slovakia s.r.o.
Viedenská cesta 5
SK-85101 Bratislava
Tel. +421 2 6252 5544
Fax +421 2 6252 5543

Tab. 24	 Contact information SAUTER subsidiaries Europe

Please refer to www.sauter-controls.com for additional contact information 
worldwide.
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11	 Rectifying problems

The following table lists typical problems that may occur during installation, 
configuration or commissioning. 

Fault Cause Rectification

SGU100 or CASE Sen-
sors reports "no valid 
teach-in values available"

The teach-in process was 
not properly completed.

ff Repeat the teach-in process. 
Make sure the stroke between 
start position and nominal 
position is at least 200 mm.

The Run/Fault LED on the 
EGP100 lights up red

The transducer's meas-
urement range has been 
exceeded.

ff Acknowledge the alarm signal 
by pressing the zero point 
button and then rebalance the 
zero point. 

The transducer may be damaged 
and no longer functional if the 
maximum permissible pressure was 
exceeded (see PDS 32.021).

ff In this case replace the trans-
ducer.

The Run/Fault LED  on 
the EGP100 flashes red

Insufficient supply voltage ff Check the wiring and voltage 
supply to the EGP100 (see 
PDS 32.021). 

Tab. 25	 Rectifying problems
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List of abbreviations

Abbreviation Term

∆p Differential pressure in Pascal

AI Analogue input

AO Analogue output

DN Nominal diameter

FS Full span; maximum measuring range

PC Personal computer
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